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 Computer Memory
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Answer: RAM

 

1.	 a. (ii)		  b. (i)	 c. (iii)	 d. (iii)
2.	 a. two	 b. nibble	 c. RAM	 d. Hard disk
3.	 a.	The basic unit for measuring the memory of a computer is byte. 
	 b.	Pen drive is used to transfer data from one computer to another and can be connected to 

the Universal Serial Bus (USB) port of a computer.
	 c.	Primary memory is the main memory of a computer system from which the CPU can access 

data directly.
	 d.	Cloud storage site is an online location that allows us to store data online. It allows us to store 

data in an off-site location which can be accessed later on any computer anywhere through 
the Internet. 

	 e.	Secondary storage devices are devices used to store data permanently. It is not directly 
accessed by the CPU. e.g. Hard Disk and Blu-ray Disc. 

4.	 RAM stands for Random Access  Memory. It is the primary memory of a computer system. Its 
content can be accessed by the CPU directly. It is volatile in nature.

	 ROM stands for Read only Memory. It is non volatile storage device. Data stored in this storage 
device is not lost even if the device is shut down.

5.	 a. Compact Disc		  b. Memory card	 c. Blu-ray disc
6.	 a. �RAM. She can use ROM because the data and information stored in this memory do not lose 

even if the computer is switched off. 
	 b. Cloud Storage

1.
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Do it yourself

 Managing Files and Folders
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Answer: Subfolder

 
1.	 a. (i)		  b. (ii)	 c. (ii)	 d. (iii)
2.	 a. start	 b. Windows 10	 c. move	 d. file
3.	 a.	Ctrl + V	 b. Directory	 c. File extension	 d. .docx
4.	 a. Live tiles are the shortcuts of applications. These tiles display information such as weather, 

news, calendar and email messages. 
	 b.	A folder is a file cabinet where we can store our files and other subfolders. 
	 c.	The Start menu in Windows 10 provides shortcuts to apps, settings, and tiles for quick access.
	 d.	To rename a folder, follow the given steps: 
		  1  Right-click the folder that you want to rename. 
		  2  Select the Rename option 
		  3  Type a new name for the folder and press the Enter key. 
	 e.	To delete a file or folder, follow the given steps: 
		  1  Open the location that contains the file/folder you want to delete. 
		  2  Right-click on the folder and select the Delete option. 
5.	 a.	Pictures 	 b. 3 	 c. 3 	 d. 1 
	 e. PowerPoint file 
6.	 a. By clicking on the Restore the selected items option in Recycle Bin.
	 b. Ava should select and cut the pictures from Downloads folder and paste them in Vacation 

Photos folder.

2.
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Answer:
	 a. 14 		 b. 23 	 c. 6

Periodic Assessment–1
(Based on chapters 1 & 2)

1.	 a. Pen drive	 b. SSD	 c. Hard disk
2.	 a. Folder	 b. Music file	 c. Excel file	 d. Document file
3.	 a. MEMORY	 b. FOLDER	 c. FILE EXPLORER	 d. COMPACT DISC
4.	 a. Hard disk	 b. Random Access Memory (RAM)	 c. Pen drive
	 d. Memory cards	 e. Blu-ray disc

 Images and Objects in Word 2016

uiz Bee
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Answer: Wrap Text

 

1.	 a. (i)		  b. (iii)	 c. (i)	 d. all
2. 	 a. Rotate 	 b. Insert 	 c. Wrapping	 d. WordArt
3.	 a. F		  b. T	 c. T	 d. F
4.	 a. We can format a shape under Format tab.

	 b. To apply WordArt to our document, follow the given steps:

		  1 	 Click on the Insert tab.

		  2 	 Click the WordArt option.

		  3 	 Select the WordArt style.

3.
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		  4 	 Type your text in the text box to apply WordArt effect.

	 c. To insert Online images, follow these steps:

		  1 	 Click on Insert tab.

		  2 	 Click on the Online Pictures option.

		  3 	 Type desired keyword in the Bing Image Search box and press the Enter key.

		  4 	 Select the picture that you want to insert.

		  5 	 Click on the Insert button.

	 d. To add text into a shape, follow the given steps:

		  1 	 Select the shape and right-click on it.

		  2 	 Choose the Add Text option.

		  3 	 Type the desired text.
5. 	 a. Devika can use the Insert tab to add pictures to her article.
	 b. To adjust the text wrapping settings, Lisa can follow the given steps:

		  1 	 Click on the picture to select it.

		  2 	 Click the Wrap Text option.

		  3 	 Select any Wrap Text style for the picture.
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Answer: 
a.  C		  b.  I	 c.  E	 d.  H

 Creating Tables in Word 2016

 

1.	 a. (ii)		  b. (i)	 c. (ii)	 d. (iii)	 e. (ii)
2. 	 a. F		  b. F	 c. T	 d. F

4.
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3. 	 a.	 	 (iii) 

	 b. 	 (iv) 

	 c. 		 (i) �

	 d. 	 (ii) 
4.	 a.	Insert 
	 b.	Layout
	 c.	Double-click
	 d.	Insert

5.	 a.	Shift + Tab

	 b	 Table Move Handle is used to select the entire table.

	 c.	There are four alignments present in Word 2016.

	 d.	To enter data in a table, follow the given steps:

		  (i) Click on the desired cell and type the data.

		  (ii) Use mouse or keyboard to move between cells.

	 e.	To insert a column, follow the given steps:

		  (i) Right-click in the cell where you want to insert the column.

		  (ii) Click on Insert, then choose the appropriate insert column option.

	 f.	 We can enhance the look of the table by following ways:

	 	 •	 By applying Border and Shading styles,

	 	 •	 Modifying the color, style, and width,

	 	 •	 Changing alignment and layout.

6.	 Splitting cells: Divides one cell into multiple rows or columns.

	 Merging cells: Combines two or more cells into a single cell.

7.	 a.	Disha should use a table in Excel to organise her work with numeric data.

	 b.	Steps to customise a table and visually appealing:

		  1 	 Insert the Table.

		  2 	 Label the Columns like Name, Phone no., Email.

		  3 	 Style the Table accordingly by using Design tab.

		  4 	 Adjust Column Widths.

		  5 	 Align the text.
		  6 	 Make It easy to read by using bold text for headers.
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Answer: 

a. 

b. 

Periodic Assessment–2
(Based on chapters 3 & 4)

1.	 a. Insert 	 b. Format tab	 c. Drawing tools
2.	

3.	 a. Tab		 b. Alt + End	 c. Down arrow	 d. Alt + Page Up key
	 e. Alt +Home	 f. Alt +Page Down key	 g. Shift + Tab

	 h. Up arrow

Test Sheet–1
(Based on chapters 1 to 4)

1.	 a. (iii)  	 b. (iii)	 c. (i)	 d. (iii)	 e. (ii)
2.	 a. nibble	 b. Start	 c. Insert	 d. Rotate 
3.	 a. F		  b. T	 c. T	 d. F
	 e. F		  f. F
4.	 a. 		 (iii) 

	 b. 	 (iv) 

	 c. 		 (i)

	 d. 	 (ii) 
5.	 a. Byte is the basic unit for measuring the memory of a computer.
	 b. Pen drive is used to transfer data from one computer to another and can be connected to 

the Universal Serial Bus (USB) port of a computer. 
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	 c. Live tiles are the shortcuts of applications. These tiles display information such as weather, 
news, calendar and email messages.

	 d. We can format shapes under Format tab.
	 e. In Word 2016, there are four types of alignments.
6.	 a. Secondary storage devices are the external storage devices that can store large amounts of 

data permanently. Examples of secondary storage devices are Hard disk and Compact disc.
	 b. To delete a file or folder, follow the given steps:
		  1  Open the location that contains the file/folder you want to delete.
		  2  Right-click on the folder and select the Delete option.
	 c. To add text into a shape, follow the given steps:
		  1  Select the shape and right-click on it.
		  2  Choose the Add Text option.
		  3  Type the desired text.
	 d. We can enhance the look of the table by following ways:
	 	 •	 By applying Border and Shading styles,
	 	 •	 Modifying the color, style, and width,
	 	 •	 Changing alignment and layout.

 Introduction to PowerPoint 2016

 

1.	 a. Cell		 b. (iii)	 c. (i)	 d. (ii)
2.	 a. slide 	 b. Quick Access Toolbar	 c. title 
	 d. Presentation
3.	 a. Ribbon	 b. Alt + F4	 c. Ribbon	 d. Slide Sorter View
4. 	 a. A presentation is a sequential display of information using text, graphics, audio, video, and 

animation.
	 b. The two components of PowerPoint are:
		  Title Bar: It is present on the top of the PowerPoint window. It displays the name of the 

presentation you are working on. On the right of the Title bar, there are three buttons: 
Minimize button, Maximize/Restore Down button and Close button. 

5.
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		  Quick Access Toolbar: It provides shortcuts to commonly used commands like Save, Undo 
and Redo. It also contains one more button, the Start From Beginning button, which is used 
to start a slide show.

	 c. The steps to save a presentation are as follows:
		  1 	 Click on the File tab.
		  2 	 Click on the Save or Save As option.
		  3 	 Click on Browse and type the file name.
		  4 	 Click on the Save button.
	 d. To delete a slide, follow the given steps:
		  1 	 Right-click on the slide in the Slide Navigation Pane.
		  2 	 Click on the Delete Slide option.
	 e. PowerPoint is a presentation software developed by Microsoft.
		  Steps to open a saved presentation:
		  1 	 Click on the File tab.
		  2 	 Click on Open.
		  3 	 Click on Browse.
		  4 	 Navigate to the folder and select the file.
		  5 	 Click on Open.
5.	 a. Slide Sorter lets Swati see all her slides at once as small thumbnails. She can easily select and 

delete the unnecessary slides without opening each one.
	 b. To add a new slide, he will follow the given steps:
		  1  Click on the New Slide drop-down list in the Slides group.
		  2  Select the type of slide that he want to add.
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Answer:
a. NOITATNESERP
b. SLIDE
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 MORE ON POWERPOINT 2016
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Answer: Slide Sorter View

 

1. 	 a. (iii) 		 b. (iii) 	 c. (i) 	 d. (ii) 
2. 	 a. Backstage  	 b. presenter	 c. nine 	 d. Slide show 
	 d. Placeholder 
3. 	 a. The slide layout is the arrangement of text, images, ClipArts, charts, etc., on a particular slide.
	 b. Outline view displays the text of each slide in the left pane. It allows us to view and edit the 

content of the slides in an outline form and move content from one slide to another easily.
	 c. The steps to add themes are as follows:
		  1 	 Click on the Design tab.
		  2 	 Select a theme from the Themes group.
		  3 	 Select a variant from the Variants group.
	 d. The features of Slide Show view are:
	 	 •	 It is used to run the presentation in full-screen mode.
	 	 •	 We can show the presentation to the audience.
	 	 •	 All applied effects are visible during the slide show.
	 	 •	 We can choose to run the show from the beginning or from the current slide.
4. 	

Reading View Slide Sorter View
Used to view the presentation in a window 
(not full screen) with simple controls.

Shows miniature versions (thumbnails) of 
all slides.

Helpful for reviewing the presentation 
easily.

Helpful for rearranging, adding, or deleting 
slides.

Slides are shown one at a time with 
navigation buttons.

All slides are displayed together on one 
screen.

Ribbon and slide pane are hidden. Full overview of the presentation is visible.

6.
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5.	 a.	Sumit will find theme options under the Design tab.
	 b.	To change the slide layout, follow these steps:
		  1 	 Select the slide to change the layout.
		  2 	 Click on Home tab.
		  3 	 Click on Layout drop-down list present in the Slides group.
		  4 	 Choose the desired layout.

 More On Internet
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Answer: Home page

 

1. 	 a. (i) 		  b. (ii)	 c. (iii) 	 d. (ii) 
2.	 a. web pages 	 b. refresh  	 c. HTML 	 d. Address bar
3.	 a.		 (iii)

	 b.		 (iv)

	 c.		  (i)

	 d.		 (ii)

4.	 a.	A web browser is a software that lets us access web pages on the World Wide Web.
	 b.	A hyperlink is a link on a web page that connects to another web page or location. It can be 

text or a picture.
	 c.	The two advantages of the Internet are:
	 	 •	 We can communicate through emails and social networking sites.
	 	 •	 We can study online and increase our knowledge.
	 d.	To avoid cyber crime, follow the given steps:
		  1 	 Use strong passwords.
		  2 	 Do not save passwords on browsers.

7.
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		  3 	 Open only trusted emails.
		  4 	 Install antivirus programs.
		  5 	 Do not share personal information online.
	 e.	Microsoft Edge is a web browser that comes with the Windows operating system. The four 

components are:
	 	 •	 Address bar
	 	 •	 Back and Forward buttons
	 	 •	 Refresh button
	 	 •	 Favourites button
5.	 a.	Amit should not enter his personal details on the website and should ask a parent or teacher 

for help.
	 b.	Rohini should stop and not enter her card details or PIN. She should tell her parents or a 

trusted adult before doing anything else.
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	 a.	www.google.com
	 b.	www.facebook.com
	 c.	www.twitter.com
	 d.	www.wikipedia.org

Periodic Assessment–3
(Based on chapters 5 & 7)

1.	

2.	 a. Title and Content	 b. Content with Caption		 c. Comparison
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3.	 a. MOZILLA FIREFOX	 b. ONLINE SAFETY

	 c. GOOGLE CHROME	 d. MICROSOFT EDGE

 Visual Processing
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1.	

2.	

3.	

uiz Bee
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1.	� b.

2.	 b.

 

1.	 a. (i) 		  b. (iv) 	 c. (i) 
2. 	 a. The ability of the brain to use and understand visual information from the environment is 

referred to as visual processing.

8.
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	 b. Direction and Maps help us in protecting the location of a particular area or an object.
3.	 a. The correct sequence we would typically follow during a museum visit:
	 	 •	 The ticket hall
	 	 •	 The exhibit of ancient artifacts
	 	 •	 The interactive science section
	 	 •	 The museum cafe
	 	 •	 The gift shop located at exit
	 b.	Do it yourself

 Blocks in Scratch

uiz Bee
Page-90

Answer: Sound block category instructs the sprite to play music.

 

1.	 a. (ii) 		 b. (i) 	 c. (ii) 	 d. (i) 
2. 	 a. T		  b. F	 c. F	 d. T
3.	 a. Logical operators are used to combine two or more conditions. They are used to test multiple 

conditions and make decisions based on whether the conditions are true or false. The three 
logical operators in Scratch are: and, or, and not.

	 b. Looks blocks are used to control the appearance of the sprite. They can make the sprite speak 
using speech bubbles, change costumes, show/hide the sprite, and apply visual effects.

	 c. The say Hello! for 2 seconds block displays a speech bubble for a specified time.
	 d.	Control blocks are used to control how the script runs, especially when repeating actions or 

pausing.
	 	 •	 wait 1 seconds: Pauses the script for the number of seconds given.
	 	 •	 repeat 10: Repeats a set of blocks 10 times.
	 e. Arithmetic operators perform basic math calculations. Scratch includes following arithmetic 

operators:

9.
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	 	 •	 Addition (+)
	 	 •	 Subtraction (−)
	 	 •	 Multiplication (×)
	 	 •	 Division (÷)
	 f.	 Relational operators are used to compare two values and return true or false. Following are 

the three relational operators used in Scratch: 
		  1.	 Greater than (>) – Checks if one number is greater than another.
			   Example: 100 > 50
		  2.	 Less than (<) – Checks if one number is less than another.
			   Example: 50 < 100
		  3.	 Equals to (=) – Checks if two values are equal.
			   Example: 50 = 50
4.	 a. This block starts playing a sound.
	 b. This block gives the x and y position of the sprite on the stage.
	 c. This block sets the size of the sprite to a specified percentage of the original size.
	 d. This block pauses the running of the script for the number of seconds.
5.	 a.	We will use Motion block and Control block. To do so, follow the given script:
		  if <(score) > (50)> then
		     move (10) steps
	 b.	Meena should use go to x: y: block. She would configure it in the following way in scratch:
		  go to x: (240) y: (-180)
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if then

say True

else

say False

= 50not if then

say True

else

say False

> <20 2050 50and25
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 Drawing Shapes in Scratch
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Answer: erase all block erases everything drawn by the pen.

 

1.	 a. (iii)		 b. (ii)	 c. (i)	 d. (ii)
2. 	 a. F		  b. T	 c. F 	 d. F
3. 	 a. The block used to erase the pen marks from the stage is the erase all block from the Pen 

category.
	 b. The Repeat block is used to run a set of blocks multiple times. You can set the number of 

repetitions. It helps avoid writing the same code again and again.
	 c. Pen blocks are used to draw on the stage using the sprite. You can make the sprite draw lines, 

shapes, and patterns as it moves. Pen blocks include commands like pen down, pen up, set 
pen color, and erase all.

	 d. To draw a circle in Scratch, follow the given steps:
		  1 	 Drag a when green flag clicked block.
		  2 	 Add the erase all block to clear previous drawings.
		  3 	 Use pen down block to start drawing.
		  4 	 Use a repeat 36 block.
		  5 	 Inside it, add:
			   •  move 10 steps
			   •  turn 10 degrees
	 e. Steps to draw a line in Scratch:
		  1 	 Drag when green flag clicked block.
		  2 	 Add the erase all block to clear previous marks.
		  3 	 Use pen down block.
		  4 	 Use move 100 steps to draw the line.

10.
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4.	 a.	From the given stacks of blocks, we can draw square.
		  `To draw the rectangle, we can make changes like,

	

pen down
repeat

when clicked

4

turn degrees90
move steps100

pen down
repeat

when clicked

3

turn degrees45
move steps100

	 b.	Maya should use the angle of 45 degree to correctly draw the octagon.
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Answer: 

	

pen down
repeat

when clicked

8

turn degrees45
move steps50

 Categories of Robots
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Answer: �Pre-programmed robots are used in  repetitive tasks that are considered boring because 
of their repetitive nature or too dangerous to be done by humans.

11.
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1.	 a. (ii)		  b. (i)	 c. (iii)	 d. (ii)
2.	 a.	Autonomous	 b. Atlas	 c. Pre-programmed
	 d. Augmenting
3.	 a.	Drone controllers are used for surveillance purposes and detecting landmines on the 

battlefield.
	 b.	WoeBot is a therapist robot designed to offer convenient care to people struggling with 

depression by mimicking human conversation and offering help and companionship.
	 c.	The Heartlander Robot is used to deliver treatment to delicate locations in the body like the 

heart.
	 d.	Humanoid robots are designed to perform human-like activities by mimicking human 

behaviour. They look like humans and also have human-like expressions. For example, Sophia.
4.	 a. Atlas	 b. Augmenting robots 	 c. Woebot
5.	 a.	Augmenting robots can assist to lift heavy objects.
	 b.	I will recommend Roomba vacuum cleaner for household cleaning tasks.
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Answer: 

	 a. @!&*%%^+	 b. BAD

Periodic Assessment–4
(Based on chapters 8 to 11)

1.	 a. This block displays a speech bubble of the sprite for a specified amount of time.
	 b. This block changes the costume of the sprite to the next costume in the costume list.
	 c. This block starts playing a sound.
2.	

Bush Apple Dustbin

B2 B3 A2
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3.	 a. CyberKnife	 b. Sophia	 c. Drone Controllers

Test Sheet–2
(Based on chapters 5 to 11)

1.	 a. (iii)		 b. (iii)	 c. (ii)	 d. (iv)	 e. (i)
	 f. (iii)		  g. (ii)
2.	 a. slide 	 b. Presentation 	 c. Backstage 	 d. presenter
3.	 a. T		  b. F	 c. F	 d. T	 e. F
	 f. T
4.	 a. The block used to erase the pen marks from the stage is the erase all block from the Pen 

category.
	 b. The Repeat block is used to run a set of blocks multiple times. You can set the number of 

repetitions. It helps avoid writing the same code again and again.
	 c. Drone controllers are used for surveillance purposes and detecting landmines on the battlefield.
	 d. WoeBot is a therapist robot designed to offer convenient care to people struggling with 

depression by mimicking human conversation and offering help and companionship.
	 e. A web browser is a software that lets us access web pages on the World Wide Web.
	 f. A hyperlink is a link on a web page that connects to another web page or location. It can be 

text or a picture.
5. 	 a. Microsoft Edge is a web browser that comes with the Windows operating system.
		  The four components are:
	 	 •	 Address bar
	 	 •	 Back and Forward buttons
	 	 •	 Refresh button
	 	 •	 Favourites button
	 b. PowerPoint is a presentation software developed by Microsoft.
		  Steps to open a saved presentation:
		  1 	 Click on the File tab.
		  2 	 Click on Open.
		  3 	 Click on Browse.
		  4 	 Navigate to the folder and select the file.
		  5 	 Click on Open.
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	 c. To delete a slide, follow the given steps:
		  1 	 Right-click on the slide in the Slide Navigation Pane.
		  2 	 Click on the Delete Slide option.
	 d. The features of Slide Show view are:
	 	 •	 It is used to run the presentation in full-screen mode.
	 	 •	 We can show the presentation to the audience.
	 	 •	 All applied effects are visible during the slide show.
	 	 •	 We can choose to run the show from the beginning or from the current slide.
	 e. To draw a circle in Scratch, follow the given steps:
		  1 	 Drag a when green flag clicked block.
		  2 	 Add the erase all block to clear previous drawings.
		  3 	 Use pen down block to start drawing.
		  4 	 Use a repeat 36 block.
		  5 	 Inside it, add:
	 	 	 •  move 10 steps
	 	 	 •  turn 10 degrees
	 f. Steps to draw a line in Scratch:
		  1 	 Drag when green flag clicked block.
		  2 	 Add the erase all block to clear previous marks.
		  3 	 Use pen down block.
		  4 	 Use move 100 steps to draw the line.


